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Figure 1   Overview of MEADEP

1. Introduction

MEADEP (MEAsure DEPendability) is a data based dependability analysis and
modeling tool. The development of MEADEP integrates techniques in graphical user
interface (GUI) programming, database engineering, dependability modeling, and
statistical/numerical analysis. Section 1.1 gives a brief overview of MEADEP. Section
1.2 describes MEADEP’s file types in tabular form. Section 1.3 discusses the contents of
this manual, and Section 1.4 describes the background of MEADEP.

1.1 Overview

MEADEP consists of four modules. These modules are:

1. The Data Pre-Processor (DPP)
2. The Data Editor and Analyzer (DEA)
3. The Model Generator (MG)
4. The Model Evaluator (ME)

Figure 1 below shows the overview of the data flow of the program and how each of
MEADEP’s modules interact with each other.

Results generated by MEADEP are either directly obtained from data or evaluated from
dependability models. Thus, the two basic types of input to MEADEP are:

& Data — structured reports containing information on event time, location, impact
and other event characteristics, and
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& Models — graphical specifications of dependability models consisting of
reliability blocks and Markov chains

In order for MEADEP to work on data, the data must be in the MEADEP required
format. Therefore, MEADEP includes the Data Pre-Processor (DPP) module which
enables you to convert already existing databases (which can be in a variety of formats
such as ASCII Delimited Text, Access, dBASE, Paradox, etc.) into the MEADEP data
format.

However, if the data is not contained in a file, and you need to input data manually, then
the Data Editor and Analyzer (DEA) module can be used. This module allows you to
create MEADEP formatted databases and to input data directly into it without any
conversion necessary.

After completing the data entry, DEA can use the data to graphically display
dependability characteristics and perform parameter estimation. The following is a list of
DEA’s graphing and parameter estimation capabilities:

& Pie charts for event distribution
& Progressive curves over time for Mean Time Between Events (MTBE) and its

confidence interval
& Histograms for Time Between Events (TBE) and for Time To Recovery/Repair

(TTR), with the option to superimpose typical analytical functions accompanied
by the results of their goodness-of-fit tests

& The mean, lower and upper bounds for failure rate, recovery time, and coverage
& Clustering analysis statistics

As mentioned above, another way to input data is by building dependability models. The
Model Generator (MG) module can be used to do this. MG is a graphical “drag and
drop” interface which allows you to create models hierarchically. The models are made
up of reliability block diagrams (including the k-out-of-n block) and/or Markov chains. A
library of dependability models, including primitive models for typical fault-tolerant
architectures and complex models for real critical systems, are included in MEADEP for
reuse by users. From these models, MG can generate text modeling files which contain
model descriptions and parameters. These text modeling files can then be used by the
Model Evaluator (ME) module to generate desired results.

Results evaluated from models include:

& Mean Time Between Failures (MTBF)
& Reliability at a time point
& Interval-reliability (average reliability) for a time interval
& Steady-state availability
& Yearly downtime

Furthermore, ME also enables you to generate and graph these results using a user-
specified range of values for a selected parameter.
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For all of its functions, MEADEP provides you with a graphical user interface (GUI) on
Windows 95 or NT featuring  menus, dialogs, pictures, printing previews, and extensive
on-line help information.

1.2 File Types

MEADEP has six file types. The table below lists these file types with their descriptions.

Type Used By Produced Contents
By

Graphical Modeling MG MG This file contains the graphical models and
File (*.mdg) parameters created in the MG module.

Library File MG MG This is a pre-defined graphical modeling file
 (*.mdl) that defines the structure of a model but does

not contain parameter values.

Text Modeling File ME, DEA MG This file contains parameters and models
(*.mdt) that ME uses to generate results. Parameters

generated in DEA can also be bounded to
parameters in this file.

Parameter File ME ME or This file contains a list of parameters and
(*.txt) any text their initial values. It can be included in

editor model evaluations performed by the ME
module.

Query File DEA Any text This file contains a specification of one or
(*.bch) editor more queries that DEA uses in its analyses.

Windows Metafile Other DEA, This file contains pie charts, histograms and
(*.wmf) Windows MG, ME line graphs produced in DEA, models

Apps. produced in MG and results produced in
ME.

1.3 Contents of Manual

This user’s manual contains information about MEADEP. It discusses MEADEP’s
functions and capabilities and gives step-by-step instructions on how to use the
program’s modules. Chapter 1 introduces you to MEADEP and contains information on
its background. This chapter also includes a brief overview of the program and lists all
the file types that can be used and created in it. Chapter 2 describes how to install
MEADEP and includes a section that runs through some quick and helpful  examples.
Chapters 3 discusses the Data Editor and Analyzer (DEA) module. Chapters 4 discusses
the Data Pre-Processor (DPP) module. Chapters 5 discusses the Model Generator (MG)
module. Chapters 6 discusses the Model Evaluator (ME) module. This manual also
includes an appendix that contains a listing and description of the library files that are
included with the MEADEP package.
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1.4 Background of MEADEP

MEADEP was developed to provide a means of quantitatively assessing the availability,
reliability and probability of failure on demand for computer-based safety systems in
nuclear power plants (referred to as “digital systems”).  Existing instrumentation and
control (I&C) systems are obsolete or obsolescent.   However, upgrading these safety
grade (Class 1E) systems to digital technology currently poses a technological and
regulatory risk.  This risk is not so much due to the technology, which is mature and
proven, as to limitations of methods used for verifying compliance with system safety
and reliability requirements. While methods for predicting analog hardware reliability
are widely accepted by the nuclear power community, this does not hold for similar
methods for Class 1E digital systems.

There are two conventional approaches to reliability and availability prediction: 1)
modeling of a system in the design phase, or 2) assessment of the system in a later phase,
typically by test. The first approach relies on probabilistic models that use component
level failure rates published in handbooks or supplied by the manufacturers. This
approach provides an early indication of system dependability, but the model as well as
the underlying data later need to be validated by actual measurements. The second
approach typically uses test data and reliability growth models. It involves fewer
assumptions than the first, but it can be very costly. The higher the reliability specified
for a system, the longer the required test. A further difficulty arises in the translation of
reliability data obtained by test into those applicable to the operational environment.

MEADEP is intended for use in the third approach: measurement-based dependability
evaluation. This approach is well suited to the operational environment, but it can also be
applied during test. The primary advance over the conventional methods lies in the use of
models for interpretation of the measurements. This methodology extracts much more
information from available data than conventional approaches. In turn, it permits
creditable assessment of the probability of rare events from measurement of (more
frequent) predecessor events and without the need of observing the actual event. Based
on measurements of operational systems, MEADEP can provide objective dependability
assessments with stated confidence levels. This is like proof of the pudding by eating,
rather than by analyzing the ingredients. A further benefit for regulatory agencies is that
the use of standardized failure rate data for digital systems provides an overview of the
performance of these systems. Measurements can be performed on commercial grade
components without requiring the vendor to reveal proprietary information or to modify
an established development process.

Critical digital systems are found in a broad spectrum of applications, and the goals of
dependability assessment vary widely among these. It is instructive to consider the
following two extremes in order to understand where the methodology and the tool
discussed in this manual are most applicable:

1. Networked systems, such as air traffic control, telephone switching, and funds
transfer

2. Stand-alone protection systems for nuclear or chemical plants
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Networked systems are characterized by:

& Continuous input, although the workload may fluctuate, making a "usage profile"
and Mean Time Between Failures (MTBF) relevant.

& Ability to tolerate occasional outages because alternate routines or similar
work-arounds can be used.

& Users that are highly motivated to keep downtime statistics and assess causes of
failures.

An earlier study found downtimes of between 30 and 35 hours per year per installation
for these systems, with between 30 and 50 percent of the downtime being due to
identified software problems .  This environment permits systematic studies of failure1

mechanisms and occurrence rates that can be used to build and validate software
reliability models. Models that assume an initial fault density and an increase in the
MTBF proportional to the faults removed are appropriate for this application area .2

In contrast, in stand-alone protection systems, the performance under routine workload is
largely irrelevant to the safety actions expected of the system in response to
malfunctions; the most important dependability criterion is probability of failure on
demand rather than mean time between failures; alternate means for accomplishing the
intended actions are not always available (human intervention or defense-in-depth of
automatic systems); and, most significant in the context of this investigation, the user
(utility, chemical plant) has no clear motivation and very little ability to keep statistics of
non-catastrophic system failures and to investigate and correct the causes of these
failures.

MEADEP has capabilities relevant to this last point by providing users of digital
protection systems with an easy means of keeping track of non-catastrophic failures and
of propagating the resulting statistics to system failure probabilities.  Furthermore, by
making it easy to collect relevant statistics and identify the potential contribution to
catastrophic events of non-catastrophic conditions, it will motivate users to investigate
and correct the causes of failures or exception conditions as they are encountered.

Of course, many applications fall between the two extremes discussed above, and the
tool will be valuable to these as well as for the specialized needs of stand-alone
protection systems.  For example, Air Traffic Control (ATC) systems which have many
characteristics of a networked system. The example shows how the tool can furnish
MTBF predictions, and also how it can estimate the fault tolerance coverage, a capability 
not provided in any of the published reliability models and the tools that support them.

The importance of the methodology and the associated tool rests partly on the
assumption that catastrophic failures in well-tested systems usually result from the
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coincidence of a number of conditions that are individually tolerable, or at least,
non-catastrophic. A  number of examples of such occurrences are documented in
NUREG/CR-6293 . That catastrophic failures result from a combination of failures and3

mistakes that individually have much lesser consequences is not restricted to digital
systems. This process is very much at work in many major industrial, transportation, and
energy generation accidents.

Potentially the greatest benefit of MEADEP is when it is used during concept
development and early design because deficiencies identified at that time can be
corrected at relatively low cost and with few side-effects. The difficulty is that no direct
measurements from the system will be available at that time. Even in these
circumstances, the tool can be used for sensitivity studies, for "what if?" investigations,
and for comparison of alternatives under a given set of parameters. As operational data
acquired by use of the tool are made available for dependability assessment during
earlier phases, these benefits will be considerably increased.
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2. Getting Started with MEADEP

This chapter contains information on how to get started using MEADEP. Section 2.1
describes the installation process and Section 2.2 runs through some examples which
will help you get familiar with MEADEP’s modules.

2.1 Installing MEADEP

Before you install MEADEP, you should be sure that your computer meets the following
requirements.

MEADEP SYSTEM REQUIREMENTS:

& IBM PC  version or fully compatible personal computer with a 486 or later®

processor
& At least 20 megabytes (MB) of hard disk space
& At least 16 MB of memory (RAM)
& Microsoft Windows 95 or NT

MEADEP’s performance on your system is affected primarily by the size of your data
and models.

The following section will guide you through the MEADEP installation process. 

Note for Novell networks, the network client program should be halted prior to
installing MEADEP.

To install MEADEP:

1. If you are installing from a CD, insert the CD into the CD drive. If you are
installing from floppy disks, insert disk 1 into its appropriate drive.

2. In the Windows Startup menu, choose Run. The Run dialog box should appear
on the screen.

3. Select the appropriate drive. If you are installing from floppy disks, choose
setup.exe. If you are installing from CD, choose “setup.bat”.

4. Follow the instructions on the screen to install MEADEP.

The MEADEP installation program will guide you through the process and at the end of
the installation, the following dialog box will appear.
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Figure 2    Last Message Box in MEADEP Installation

Figure 3   A Dialog Box in ODBC Installation

After clicking “OK”, the MEADEP installation is completed. If this is your first time
installing MEADEP (version 1.1 or higher), run the “DATAACC.EXE” program found
under the MEADEP program directory. When you run this program it will first ask you if
you want to install the Microsoft Data Access Pack, click “YES”. This will initiate the
installation process and will guide you through the procedures. When you get to the
dialog shown below, choose “Select All” and click “Continue”. This will complete the
installation process.
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If this is not your first time installing MEADEP, make sure you have the most recent
version of ODBC. To do this, click the ODBC icon in your Window’s Control Panel and
under the “ODBC Drivers” tab, check to see if you have at least the Microsoft Access
Driver 3.50 or later. If you do not have this driver or you cannot find the ODBC icon or
the ODBC Driver tab, run the “DATAACC.EXE” program found under the MEADEP
program directory and follow the instructions given above.

When the installation is completed, you should restart your computer to ensure that new
settings take effect. After you restart your system, you should find the following
programs under your MEADEP menu.

& Data Editor & Analyzer
& Data Pre-Processor
& Model Evaluator
& Model Generator

2.2 Examples

This section runs through some examples that will help you get familiar with
MEADEP’s modules. The “Example” directory included in the MEADEP package
contains example files that you can use to help you learn about MEADEP.

2.2.1 Data Editor and Analyzer (DEA) Examples

First, run the Data Editor & Analyzer (DEA) module found under the MEADEP menu.
After the DEA main form appears, choose the “Open” command under the File menu. If
this is your first time opening the “Plant” example database, follow these instructions:

1. In the “Select Data Source” box, under the “Machine Data Source” tab, click “New”.
2. In the “Create New Data Source” box, select either the “User Data Source” or the

“System Data Source” option and click Next. If you are running Windows NT, and
you choose the “User Data Source” option, then other users must use the same logon
as you to see this data. However, if you choose the “System Data Source” option,
than other users can also access the data even if they use a different logon.

3. Then, select the “Microsoft Access Driver” and click Next and then Finish.
4. In the “ODBC Microsoft Access 97 Setup” box, enter the name of the data source.

For clarity, we suggest you use “MEADEP Example Database” as the data source
name. Click “Select”.

5. Go to the \MEADEP\Example directory (unless you specify otherwise) and pick the
database called “Plant.mdb” and click “OK” twice.

6. Select the new data source you just created (“MEADEP Example Database”) in the
“Machine Data Source” tab and press “OK”.

7. In the “Choose Table Name” box, choose the “Channel” table and click “OK”.

If you have already created a data source by following the above steps, to re-open it, just
do steps 6 and 7 after choosing “Open” under the File menu.

This database is in the MEADEP data format and contains information on component
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Figure 4   Example of Event Pie Chart

failures in an assumed digital safety system in a plant for a period of two years (1995/1/1
to 1996/12/31).

When you open this database in DEA, the DEA main form will display the first record of
the database. The database contains 12 records (shown on bottom of form), each record
corresponding to a single failure. A record has fields which contain information about
the failure. For example, the first failure (i.e. record 1) was a hardware failure. The
component that failed was the Central Processing Unit (CPU). It occurred once (Count
field) on February 1, 1995 and lasted for 1 hour. A coverage value of “1” means that the
failure was compensated by switching to another standby component. Now, let us run
through some of DEA’s graphical and analytical capabilities.

Event Pie Chart

First, we’ll generate an event pie chart (Section 3.3.1 in this manual) for the 4 top items
in the Component field. This means that the 4 items that occur the most times in the
component field will be graphed. To do this, follow these instructions:

1. Select the “Event Pie Chart” option in the Graphical-Analysis menu
2. Under “Select a field by which to draw chart” choose “Component” and click

“OK”.
3. Specify “4” for the number of top items and click “OK”.

The event pie chart as shown in Figure 4 will appear displaying the four top items in the
Component field and what percentage of times they appear. The figure shows that
number of events for IO, CPU, Power and OS is 4, 4, 2 and 2, respectively.

Duration Pie Chart

Similar to the above example, we can generate an duration pie chart (Section 3.3.2 in this
manual) for the items in the Component field. This means that the outage time for each
item in the component field will be graphed. To do this, follow these instructions:
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Figure 5   Example of Duration Pie Chart

1. Select the “Duration Pie Chart” option in the Graphical-Analysis menu
2. Under “Select a field by which to draw chart” choose “Component” and click

“OK”.
3. In the next dialog box, click “OK”.

The duration pie chart as shown in Figure 5 will appear displaying the outage times and
their percentage for the four items in the Component field. The figure shows that the
outage time for Power, IO, CPU and OS is 8, 6, 4 and 2 hours, respectively.

MTBE Line Graph

For the last graphical analysis example, let us graph a Mean Time Between Events
(MTBE) Line Graph.

1.   Select the “MTBE Line Graph” option in the Graphical-Analysis menu.

2. Choose a value of 0.8 for the confidence level (for information on “confidence
level, see Section 3.3.5 in this manual). Also, enter the amount of time to be
considered in the calculation. For this example, let us pick a time interval from
January 1, 1995 to December 31, 1996. Finally, enter “3 months” for the time
between plotted points and click “OK”.

The line graph with it’s upper and lower bounds will be displayed as shown in Figure 6.
For more information on MTBE line graphs, see Section 3.3.5 in this manual.
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Figure 6  Example of MTBE Line Graph

Failure Rate

Now we’ll move on to a parameter analysis example. First, let us calculate the failure
rate for the CPU component and its upper and lower bound values. Choose the “Failure
Rate” option under the Statistics-Estimation menu (Section 3.4.3 in this manual). Specify
a confidence level of 0.8 and click “OK”. Then, in the “Specification of Criteria in
Selecting Records” box, enter “CPU” in the “Component” field. This selection will only
include those failures that occurred in the CPU in the calculation. After clicking “OK”,
the “Iteration Specification” box will appear with some resulting calculations. The
number of events selected should be 4 and the total elapsed time should be 8352 hours.
This means that 4 out of the 12 failures occurred in the CPU component and that from
the first CPU failure to the last CPU failure, there were 8352 hours.

Where MEADEP asks you to add additional records to be included in the statistic,
choose “No” (unless you are interested in adding more records) and the failure rate with
its upper and lower bound values will be displayed. You can bind these results to
parameters in a text modeling file by choosing the “Insert into Modeling File” option.
When you choose this option, you will be asked to open the desired modeling file
(*.mdt) and you will be given detailed instructions on how to bind these results to
parameters in the file. See Section 6.1 in this manual for information on text modeling
files.

Multiple Statistics

Now we show how to obtain multiple statistics for multiple queries by running a query
file. For more information on multiple statistics and query files, see Sections 3.4.6 and
3.4.7 in this manual. First choose “Multiple Statistics” option under “Batch-Processing”
menu. Then specify a confidence level of 0.8 and click “OK”. In the “Open” box, select
file “Plant.bch” under the “Example” subdirectory in your MEADEP program directory
and open it. Multiple statistics results for failures of two types - Software and Hardware -
and of four components - OS, CPU, IO, and Power - will be displayed on the screen as
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Figure 7   Example of Multiple Statistics Results

shown in Figure 7 below. You can click the scroll bar on the screen to view these six
groups of statistics.

The “Plant.bch” you just used is a simple text file. It contains the following query
specifications (Section 3.4.7 discusses the format and keywords that can be used in a
query file):

StartDate 1995/01/01
EndDate 1996/12/31
Type Software

StartDate 1995/01/01
EndDate 1996/12/31
Type Hardware

StartDate 1995/01/01
EndDate 1996/12/31
Type Software
Component OS

StartDate 1995/01/01
EndDate 1996/12/31
Type Hardware
Component CPU
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StartDate 1995/01/01
EndDate 1996/12/31
Type Hardware
Component IO

StartDate 1995/01/01
EndDate 1996/12/31
Type Hardware
Component Power

TBE and TTR Distributions

A distinguished advantage of MEADEP is its ability to identify if an empirical Time
Between Events (TBE) or Time To Repair (TTR) distribution statistically matches one
of the five commonly used probability distribution functions: exponential, gamma,
Weibull, normal, and lognormal. When DEA displays a histogram (for more information
on the histogram see Sections 3.3.3 and 3.3.4 in this manual) for a TBE or TTR
distribution, it allows the user to super-plot, over the histogram, the above five analytical
functions determined by the sample mean and sample variance. Meanwhile, the
estimated parameters for these functions as well as the results of the Chi-Square (Chi)
and  Kolmogorov-Smirnov (KS) goodness-of-fit tests are also provided on the screen and
automatically copied to the clipboard.

To show this capability, we now close the “Channel” table by clicking the File/Close
command. Then we choose the File/Open command.  Select “MEADEP Example
Database” (the data source you created in Sec. 2.1.1) in the “Machine Data Source” tab
and press “OK”. In the “Choose Table Name” box, choose the “Facility” table and click
OK. You’ll see “Number of records in current selection: 1067" at the bottom of the DEA
main window. This table contains outage data for facilities A, B, ..., H for a period over
five years.

Now choose the Database-Operation/Query Records command. In the “Type” box, type
“A” and then click “OK” to select all records for facility type A. You’ll see that 146
records are selected.

To identify TBE distribution for this facility:

1. Choose Graphical-Analysis/TBE Distribution
2. Click “OK” in the “Interval Specification” screen
3. Click “Draw Histogram” in the “TBE Distribution Results” screen
4. Click the “Exponential” , “Gamma” and “Weibull” buttons in the “Histogram

Display” screen

The resultant screen is shown in Figure 8. You can see the TBE distribution better
matches the Weibull function because it passed both the Chi and KS tests (>0.05) while
the other two functions only passed the KS test.
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Figure 8  Identification of TBE Distribution

To identify TTR distribution for this facility:

1. Choose Graphical-Analysis/TTR Distribution
2. Click “OK” in the “Initial Value Specification” screen
3. Click “OK” in the “Interval Specification” screen
4. Click “Draw Histogram” in the “TBE Distribution Results” screen
5. Click the “Exponential” , “Gamma” and “Weibull” buttons in the “Histogram

Display” screen

You can see the TTR distribution matches both the gamma and Weibull functions (both
passed the Chi and KS tests) but does not matches the exponential function which failed
to pass either Chi and KS tests.
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Figure 9   Diagram “Plant”

2.2.2 Model Generator (MG) Examples

Text modeling files are generated from graphical models that are “designed” in the
Model Generator (MG) module. Let us now run through a quick example on how to
generate a text modeling file.

First, run MG from the MEADEP main menu. For our example, we will use an existing 
graphical modeling file named “Plant.mdg” found in the \MEADEP\Examples directory
(for instructions on how to design graphical modeling files, see Section 5.1 in this
manual). After you load up MG, open this file. The top level diagram (“Plant”) will
appear on the screen. To expand to the lower level diagram (“SafSys”) choose “Expand”
from the Diagram menu. The cursor will change to a magnifying glass with a “plus” sign
inside it. Go to the frame (a box with the word “SafSys” inside it with a bunch of Greek
fonts under it) and click inside it. This will take you to the lower level diagram called
“SafSys”. Then, you can expand “SafSys” to see its lower level-diagram by expanding
the “Channel” frame. The three diagrams are shown below. A detailed description of this
model is given in Appendix A.
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Figure 10   Diagram “SafSys”

Figure 11   Diagram “Channel”

Now we’ll generate the text modeling file. Choose the “Generate Text Modeling File”
option in the File menu. A text modeling file for the “plant.mdg” model called
“plant.mdt” is already included in the Example directory. You can overwrite this file or
give the new generated file another name. After choosing the name and location of your
text modeling file, click “Save”. MG will validate the model and if it is valid you will be
asked to:

& bind values to parameters in your model,
& enter the models/submodels you want to include in the output list of your text

modeling file, and 
& include any comments you want displayed before each model’s/submodel’s

output results.

After completing the above procedures, MG will notify you that your new text file has
been created.
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Figure 12   Example of “Loop By Value Set” Generated Graph

2.2.3 Model Evaluator (ME) Examples

Now that we have a text modeling file, we’ll generate some results using the Model
Evaluator (ME) module. First, run ME from the MEADEP main menu and open the text
modeling file you just created. It will appear on the screen. Let us first generate the Mean
Time Between Failures (MTBF) results for the “Plant” submodel given a set of values
for the  “Ps” parameter. To do this, choose the “Loop by Value Set” command found in
the Solution menu. When you run this command, you will be asked to specify a
parameter and a set of values for the parameter. Specify “Ps” as your parameter and input
a set of values as indicated. Because “Ps” is a probability, you can only choose values
between 0 and 1. Let us choose:

& 0.1, 0.2, 0.3, 0.4, 0.5, 0.6, and 0.7 as the set of values for “Ps”,
& “Plant” for the model, and 
& MTBF as your measure.

This selection will generate a box containing a set of values for the “Ps” parameter and
their corresponding MTBF values. You will be able to graph the results and save the
graph as a Windows Metafile (*.wmf) for inputting into other programs. The graph is
shown in Figure 12.

For the last example, let’s generate the failure rate, restoration rate, availability, and
unavailability results for our model. You can calculate all these measures with one
simple command. This command is the “Regular Results” command found in the
Solution menu. After you choose this command, the above results will be displayed for
only those submodels that are listed in the output specification section of the text
modeling file. You will be given a choice to copy these results to the clipboard and to
save them as a text file.
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Figure 13   DEA’s Main Menus

3. Data Editor and Anal yzer (DEA) Module

The Data Editor and Analyzer (DEA) module works on data and performs statistical
analysis on it. The results of DEA’s statistical analysis can be graphed or bound to
parameters that are found in text modeling files (created in the Model Generator
module). Figure 13 shows DEA’s Main Menu commands. These commands will
individually be explained in later sections.

DEA has three major functions:

Data Editing- Data Editing includes correctness checking for data formatting, querying
records, sorting records, adding records, deleting records, undo changes, consolidating
fields, saving records, assigning a constant string to a field and more.

Graphical Analysis- Graphical Analysis can generate pie-charts for event distributions,
histograms for Time Between Events (TBE) or Time To Recovery/Repair (TTR)
distributions, and progressive curves for Mean Time Between Failures (MTBF) and its
confidence interval over the time axis. Graphical analysis can be specified by the user
through multiple window dialogs.

Parameter Estimation- Parameter Estimation provides the mean, upper and lower bounds
at a specified confidence level for the following: Mean Time Between Failures (MTBF),
Mean Time To Recovery/Repair  (MTTR), failure rate, recovery/repair rate, and fault-
tolerance coverage. Estimates are also given even if failures are rare. These estimates can
then be inserted into a text modeling file for binding to model parameters. Parameter
estimation can be specified by the user through multiple window dialogs and can also be
specified by a predefined query command file (Section 3.4.7).

***Please note: Before doing any Graphical Analyses or Parameter Estimations for the
first time, you should run the “Check Records” command (Section 3.2.3). This command
will normalize the date field and avoid incorrect results.
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Figure 14   DEA’s Main Form

3.1 Getting Started

In order for DEA to run successfully, MEADEP must be fully installed. To run the DEA
module, go to the MEADEP program group in the Windows Program menu and select
the DEA menu item.  You can also create a DEA shortcut for quicker and easier
accessability. See your Windows Manual on how to do this.

When you first run DEA, the main form used in DEA for viewing and editing database
records appears. This form is shown below.

The form remains blank until a database is opened or created. Afterward, the main form
will display the data for all MEADEP-defined fields (listed in the table below) in the
current record. You can scroll back and forth through records and edit records using the
commands described in the Data Editing section of this report (Section 3.2). The total
number of records in the database and the index of the record currently displayed are
always shown at the bottom of this form.

The database fields displayed on DEA’s main form are listed and described in the
following table:
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Field Name Description Format/Units Comments

Event ID Identification of the event String Limited to 512
characters

Date Date on which the event occurred yyyy/mm/dd Stored as a string

Time Time at which the event occurred hh:mm:ss Stored as a string

Duration Duration of the event Hours Stored as a “double”
number

Type Type of the event String Limited to 512
characters

Location Where the event occurred String Limited to 512
characters

Subsystem Subsystem in which the event occurred String Limited to 512
characters

Component Component in which the event String Limited to 512
occurred characters

Cause Cause of the event String Limited to 512
characters

Criticality Degree in which the event impacted the String Limited to 512
system characters

Coverage Indication if the failure event has been 0 or 1 Stored as an integer
covered by redundancy provisions

Count Number of occurrences of the event 1 or more Stored as an integer

Notes Description for or comments on the String Limited to 4096
event characters

Creating MEADEP-formatted Databases in DEA and DPP

In order for DEA to analyze the data, the data must be in the MEADEP required format.
You can generate a database with this required format in two ways. 

1.  If the data is already stored in an existing non MEADEP-formatted database
then you should first run the MEADEP Data Pre-Processing (DPP) module
which converts your database’s current data format into the MEADEP required
format (see the DPP section in this user’s manual). 

2.  If you don’t have an existing database, you can create a MEADEP formatted
database using DEA itself. This option is useful when your source data are hand-
written event logs. Following these instructions will help you do that.

2. Choose File Open.
2. Choose New under the “Machine Data Source” tab.
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3. In the “Create New Data Source” box, select either the “User Data Source”
or the “System Data Source” option and click Next. If you are running
Windows NT, and you choose the “User Data Source” option, then other
users must use the same logon as you to see this data. However, if you
choose the “System Data Source” option, than other users can also access
the data even if they use a different logon.

4. Then, select the “Microsoft Access Driver” and click Next and then Finish.
5. In the “ODBC Microsoft Access 97 Setup” box, select “Create” and enter

the database’s name and location.
6. Choose “OK”.
7. Enter information about the data source, such as its name and description.
8. Choose “OK”.
9. In the Select Data Source box, choose the data source you just created under

the “Machine Data Source” tab and Choose “OK”.
10. Choose “Create New Table” and enter the table’s name.
11. Choose “OK” twice.

A blank form will be displayed and in order to enter data into your new database,
you will have to add a new record and start inputting the data (see Section 3.2.6 for
more information).

Opening MEADEP-formatted Databases in DEA

To open an existing database in DEA that is in the MEADEP required format and has a
data source, do the following:

1. Choose “Open” under the File menu.
2. Select the data source in the “Machine Data Source” tab and press “OK”.
3. Then, in the “Choose Table Name” box, choose the table you wish to open and click

“OK”.

The first record in the database should appear on the screen.

The following sections describe the data editing commands that DEA provides.

3.2 Data Editing Commands

DEA provides data editing and record manipulation commands for querying, sorting,
checking, inserting, deleting, editing, and copying records. The following sections
describe each of these commands and functions in further detail.
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Figure 15   Query Form

3.2.1 Querying Records

The “Query Records” command is used for selecting a set of records from the DEA
database. The “Query Records” command can be found in the Database-Operation menu.
Queries are performed from the dialog box shown in Figure 15. The keywords for
specifying search criteria are explained below:

StartDate, StartTime, EndDate, EndTime: Records whose Date and Time fall in
the period between the time point determined by StartDate and StartTime and the
time point determined by EndDate and EndTime meet these criteria. If no values
are specified for these four keywords, no criteria will be applied to the Date and
Time fields in selecting records. In this case, for the purpose of estimating
statistics, the default StartDate and StartTime will be the Date and Time values
of the first record in the selection, and the default EndDate and EndTime will be
the Date and Time values of the last record in the selection.
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MinimumDuration, MaximumDuration: Records whose Duration value is
between MinimumDuration and MaximumDuration meet these criteria. If both
MinimumDuration and MaximumDuration are zero (default value), no criteria
will be applied to the Duration field in selecting records.

Type, Location, Subsystem, Component, Cause, Criticality, Coverage: These
keywords are actual field names of the MEADEP data schema. If values are
specified for a field, the selected records must match the specified values. If no
value is specified for a field, no criteria will be applied to that field in selecting
records. In the value specification, the wildcard % can be used. For example,
ABC% will match any strings starting with ABC.

Copies: This keyword is meaningful only for commands in the Statistics-
Estimation menu. The value of Copies represents the number of systems from
which the data were collected (and thus the measurement time should be
multiplied by this number).

3.2.2 Sorting Records

The “Sort Records” command can be found in the Database-Operation menu. Use this
command to sort all records in the database. You will be asked to specify up to three
fields as sort criteria. The sort command will sort the records in ascending order.

3.2.3 Checking Records

The “Check Records” command can be found in the Database-Operation menu. Use this
command to check the correctness of the format for all records in the database.  You
should run this command immediately after converting a database to the MEADEP
format with the DPP module (see Section 4). The command will normalize the “Date”,
“Time”, and “Notes” fields and avoid incorrect results. This operation can be aborted at
any point in the database and later continued with the “Resume Checking” command
found in the same menu.

3.2.4 Resume Checking 

The “Resume Checking” command can be found in the Database-Operation menu. Use
this command to continue an aborted run of the “Check Records” command from the
point of interruption.

3.2.5 Moving Through Your Database

In the Record-Operation menu, you are given the following four choices for moving
through the database:

First Record —This command goes to the first record in the current database.
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Last Record — This command goes to the last record in the current database.
Next Record — This command goes to the next record in the current selection.
This command will be disabled if you are currently viewing the last record.
Previous Record — This command goes to the previous record in the current
database. This command will be disabled if you are currently viewing the first
record.

3.2.6 Adding Records

The “Add Record” command can be found in the Record-Operation menu. Use this
command to add a new record to the currently opened or created database.

3.2.7 Deleting Records

The “Delete Record” command can be found in the Record-Operation menu. Use this
command to delete the record currently displayed on the screen from the database.

3.2.8 Undo Changes

The “Undo Changes” command can be found in the Record-Operation menu. This
command refreshes the screen and discards any changes made to the current record. It
also cancels the “Add Record” command if the new record has not yet been saved.

3.2.9 Save Record

The “Save Record” command can be found in the Record-Operation menu. Use this
command to save the newly created record to the database. To save any changes made to
an already existing record, just move to the previous or next record.

3.2.10 Consolidate Command

The “Consolidate” command can be found in the Field-Operation menu. Consolidation
means replacing a set of one or more distinct values with one single value. For example,
if inconsistent nomenclature are used (“Black”,”Blk”,”B”) then these can be
consolidated into a single category. Consolidation can also be used to aggregate more
detailed information into higher level categories. For instance, if you want to consolidate
the “Location” field by grouping the locations by region, this command could be used to
replace California, Nevada, Arizona, and Oregon with the string West (see Figure 16
below). You will be asked to select a field, to choose a set of source values from among
all existing values in that field, and to specify a destination value to substitute for the
chosen set of source values.
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Figure 16   Consolidate Form

3.2.11 Assign Constant

The “Assign Constant” command can be found in the Field-Operation menu. Use this
command to assign a constant string to a field. You will be asked to select a field and to
specify a string to replace or to append to the current values in the selected field for
every record. If you click the Replace button, then the string entered in the text box will
replace the contents of the selected field in every record of the current selection. If
you click the Append button, then the string entered will be appended to the contents of
the selected field in every record of the current selection.

3.2.12 Extract and Copy Command

The “Extract and Copy” command can be found in the Field-Operation menu. Use this
command to extract a substring (or the whole string) from a field and copy or append it
to another field. You will be asked to:

& Select a source field and a destination field
& Specify the start position and length of the substring that will be extracted from

the source data
& Click the Replace or Append button to perform the operation.
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3.3 Graphical Analysis

The graphical analysis functions of DEA allow for the presentation of MEADEP data in
any of the following formats:

& Pie-charts for event distributions
& Histograms for Time Between Events (TBE) and Time To Recovery/Repair

(TTR) distributions
& Progressive curves for Mean Time Between Events (MTBE) and its confidence

interval over the time axis.

Graphical analysis can be specified by the user through multiple window dialogs as
described in the following sections.

3.3.1 Event Pie Chart

The “Event Pie Chart” Distribution command can be found in the Graphical-Analysis
menu. This command generates a pie chart for the distribution of events according to the
data contained in a particular database field. Events can be filtered by first invoking the
Query command from the Database-Operation menu (Section 3.2.1). When the Event Pie
Chart command is invoked, you will be asked to specify the database field for which the
distribution is to be charted and to choose whether to chart the distribution of events
relating to  a ‘Single Item’ in the specified field or relating to ‘Top Items’ in this field. If
‘Single Item’ is chosen, you are then going to be asked to select the item from those
items available in the specified field. If ‘Top Items’ is chosen, you will be asked (in the
“Choose a Value” box) to select the number of high frequency items to distinguish in the
distribution.

The Event Pie Chart command also enables you to:

& Print the pie chart directly to a printer
& Output the pie chart to a Windows metafile or
& Copy the pie chart to the clipboard for pasting into another application.

An example of event pie chart is shown in Figure 4.

3.3.2 Duration Pie Chart

The “Duration Pie Chart” Distribution command can be found in the Graphical-Analysis
menu. This command generates a pie chart for the distribution of cumulative event
duration according to the data contained in a particular database field. Events can be
filtered by first invoking the Query command from the Database-Operation menu
(Section 3.2.1). When the Event Pie Chart command is invoked, you will be asked to
specify the database field for which the distribution is to be charted and to choose
whether to chart the distribution of event duration relating to  a ‘Single Item’ in the
specified field or relating to ‘Top Items’ in this field. If ‘Single Item’ is chosen, you are
then going to be asked to select the item from those items available in the specified field.



S2



M
N

i
1

(TBEi	Mean)2

N

MEADEP User’s Manual  28

If ‘Top Items’ is chosen, you will be asked (in the “Choose a Value” box) to select the
number of high duration items to distinguish in the distribution.

The Duration Pie Chart command also enables you to:

& Print the pie chart directly to a printer
& Output the pie chart to a Windows metafile or
& Copy the pie chart to the clipboard for pasting into another application.

An example of duration pie chart is shown in Figure 5.

3.3.3 Time Between Events (TBE) Distribution Histograms

The “Time Between Events” (TBE) Distribution command can be found in the
Graphical-Analysis menu. This command generates a histogram for the Time Between
Events distribution of events. Before using this command, you should select the
appropriate record set. This set can be selected by invoking the Query command from the
Database-Operation menu (Section 3.2.1). When the TBE Distribution command is
invoked, a box will appear prompting you to specify the number of intervals and the
interval size.

After you specify the above, click “OK”. The “TBE Distribution Results” box should
appear, displaying the following parameter results:

& TBE Count — Number of TBEs.
& TBE Mean — Average TBE value (In Hours)
& TBE Maximum — Maximum TBE value (In Hours)
& TBE Minimum — Minimum TBE value (In Hours)
& TBE Variance — The formula for the TBE Variance (S) is shown below (In

Hours)

& Histogram Data — Consisting of the number of TBEs and their corresponding
interval midpoint values

If desired, you can edit these results and copy them to the clipboard for use in another
application. Once you click “Draw Histogram”, a histogram graph similar to the one in
Figure 17 below will appear.
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Figure 17   TBE Distribution Histogram

In this particular graph, you see that there are 43 TBE values in the range of 0 to 85
hours. These values constitute ~63% of the total number of TBE instances. Also, you can
see that for the range  of 85 to 170 hours, there are 6 TBE values which constitute ~9%
of the total number of TBE instances. And so on.

Once the results have been graphically displayed on the screen, you can “superimpose”
the exponential, gamma, Weibull, normal and lognormal PDF (Probability Density
Function) curves on the screen. The display of each of these curves can be individually
toggled on and off via independent radio buttons. The curves are determined by the
sample mean and the sample variance. Superimposing these curves will allow you to see
if the histogram is close to one of the five analytical functions.

In addition, the estimated parameters for these functions as well as the results of the Chi-
Square and Kolmogorov-Smirnov goodness-of-fit tests are displayed. The Chi-Squared
test and Kolmogorov-Smirnov goodness-of-fit test are two statistical methods which
measure how well the analytical distribution calculated by MEADEP fits the empirical
distribution estimated from the data. The results for each test provided by MEADEP is
the significance level at which the assumption that the empirical distribution matches the
analytical distribution cannot be rejected. A significance level of 0.05 is the minimum
value typically used for acceptance.

3.3.4 Time To Recovery/Repair (TTR) Distribution Histogram

The “Time To Recovery/Repair” (TTR) Distribution command can be found in the
Graphical-Analysis menu. This command generates a histogram for the Time To
Recovery/Repair distribution of events. Events can be filtered by first invoking the
Query command from the Database-Operation menu (Section 3.2.1). When the TTR
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Distribution command is invoked, you will first be asked to specify a default
recovery/repair time to be used for event records that lack this information. The default
value as 0.5 hours is used if no input is provided. Once a default value is given and you
click “OK”, a box will appear prompting you to specify the number of intervals and the
interval size.

After you specify the above, click “OK”. The “TTR Distribution Results” box should
appear, displaying the following parameter results:

& TTR Count — Number of TTRs.
& TTR Mean — Average TTR value (In Hours)
& TTR Maximum — Maximum TTR value (In Hours)
& TTR Minimum — Minimum TTR value (In Hours) 
& TTR Variance — The formula for the TTR Variance (S) is shown below (In

Hours)

& Histogram Data — Consisting of the number of TBEs and their corresponding
interval midpoint values

If desired, you can edit these results and copy them to the clipboard for use in another
application. Once you click “Draw Histogram”, a histogram graph similar to the one in
Figure 14 will appear.

As was the case with the TBE Distribution, once the results have been graphically
displayed on the screen, you will be given options to superimpose the exponential,
gamma, Weibull, normal and lognormal PDF (Probability Density Function) curves on
the screen. The display of each of these curves can be individually toggled on and off via
independent radio buttons. The curves are determined by the sample mean and the
sample variance. Superimposing these curves will allow you to see if the histogram is
close to one of the five analytical functions.

In addition, the estimated parameters for these functions as well as the results of the Chi-
Square and Kolmogorov-Smirnov goodness-of-fit tests are displayed. The Chi-Squared
test and Kolmogorov-Smirnov goodness-of-fit tests are two statistical methods which
measure how well the analytical distribution calculated by MEADEP fits the empirical
distribution estimated from the data. The results for each test provided by MEADEP is
the significance level at which the assumption that the empirical distribution matches the
analytical distribution cannot be rejected. A significance level of 0.05 is the minimum
value typically used for acceptance.
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3.3.5 Mean Time Between Events (MTBE) Line Graph

The Mean Time Between Events (MTBE) command can be found in the
Graphical-Analysis menu. This command generates a line graph of the Mean Time
Between Events, and its upper and lower bounds at a specified confidence level. You
will be asked to specify a confidence level and to select a set of records (based on start
time, end time, start date, and end date) for the estimation.

The confidence level is a value between .5 and .99 which represents the user’s desired
confidence that an actual mean will be guaranteed to fall somewhere between the upper
and lower bounds/curves calculated by the program. Please take note that the confidence
level does not affect the calculation of the mean itself. The closer the confidence level is
to .99, the larger the gap will be between the upper and lower bounds/curves, thereby
giving greater assurance that the actual mean will fall somewhere between them.

After you have inputted all your desired Range Specifications, you are now ready to
generate the line graph. You can do this by clicking “OK”. The resulting values are
calculated by the chi-squared function and the exponential distribution is assumed in
estimating upper and lower bounds.

Once the chart is displayed on the screen, buttons will appear just below the chart. These
buttons enable you to:

& print the chart
& output the chart to a Windows metafile or
& copy it to the clipboard for pasting into another application.

3.4 Parameter Estimation

Three parameters can be estimated from data by DEA:

& Failure Rate and Mean Time Between Events (MTBE)
& Recovery/Repair Rate and Mean Time To Recovery/Repair (MTTR)
& Coverage

For these parameters, MEADEP estimates the following three quantities:

& the point estimate
& the lower bound at a user-defined level of confidence and
& the upper bound at a user-defined level of confidence

DEA enables you to insert these estimates into a text modeling file for binding to model
parameters (see Section 6.1). Parameter estimation can be specified by the user through
multiple window  dialogs (query sessions) and can also be specified by a predefined
query command file. See Section 3.4.7 for a detailed description on query files.
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3.4.1 Mean Time Between Events (MTBE)

This command can be found in both the Statistics-Estimation menu and Query
Processing menu. Use this command to estimate the Mean Time Between Events, and its
upper and lower bounds at a specified confidence level.

When you run this command, you will be first prompted to specify a confidence level
(see Section 3.3.4). Then, you will be asked to select a set of records. If you chose the
command from the Statistics-Estimation menu, you will be asked to select a set of
records from the “Specification of Criteria in Selecting Records” form (similar to the
Query command discussed in Section 3.2.1). Then, you will be prompted to choose
whether you want to include any additional records in the analysis. If you choose “No,”
then the results will be displayed. However, if you choose “Yes,” the “Specification of
Criteria in Selecting Records” form will be displayed again, where you will be able to
select the additional records. After completing your record selection, choose “OK” and
the results will be displayed.

When results are displayed on the screen, you will be given an option to open a text
modeling file (*.mdt files produced in the Model Generator Module) and to bind (i.e.
used to set the value of) the results to parameters in the file.

3.4.2 Mean Time To Recovery/Repair (MTTR)

This command can be found in both the Statistics-Estimation menu and Query
Processing menu. Use this command to estimate Mean Time To Recovery/Repair, and its
upper and lower bounds at a specified confidence level. In order for DEA to calculate the
required results, you will be asked to:

& specify a confidence level (see Section 3.3.4)
& define a default value for the Recovery/Repair time for those records which do

not contain the event duration information (a suggested value is provided)
& choose whether to use a normal distribution or an exponential distribution

(needed for the calculation of the upper and lower bounds)

Then, you will be asked to select a set of records. If you chose the command from the
Statistics-Estimation menu, you will be asked to select a set of records from the
“Specification of Criteria in Selecting Records” form (similar to the Query command
discussed in Section 3.2.1). Then, you will be prompted to choose whether you want to
include any additional records in the analysis. If you choose “No,” then the results will
be displayed. However, if you choose “Yes,” the “Specification of Criteria in Selecting
Records” form will be displayed again, where you will be able to select the additional
records. After completing your record selection, choose “OK” and the results will be
displayed.

When results are displayed on the screen, you will be given an option to open a text
modeling file (*.mdt files produced in the Model Generator Module) and to bind the
results to parameters in the file.
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3.4.3 Failure Rate

This command can be found in both the Statistics-Estimation menu and Query
Processing menu. Use this command to estimate the Mean Failure Rate, and its upper
and lower bounds at a specified confidence level.

When you run this command, you will be first prompted to specify a confidence level
(see Section 3.3.4). Then, you will be asked to select a set of records. If you chose the
command from the Statistics-Estimation menu, you will be asked to select a set of
records from the “Specification of Criteria in Selecting Records” form (similar to the
Query command discussed in Section 3.2.1). Then, you will be prompted to choose
whether you want to include any additional records in the analysis. If you choose “No,”
then the results will be displayed. However, if you choose “Yes,” the “Specification of
Criteria in Selecting Records” form will be displayed again, where you will be able to
select the additional records. After completing your record selection, choose “OK” and
the results will be displayed.

When results are displayed on the screen, you will be given an option to open a text
modeling file (*.mdt files produced in the Model Generator Module) and to bind the
results to parameters in the file.

3.4.4 Recovery/Repair Rate

This command can be found in both the Statistics-Estimation menu and Query
Processing menu. Use this command to estimate the mean recovery/repair rate, and its
upper and lower bounds at a specified confidence level. In order for DEA to calculate the
required results, you will be asked to:

& specify a confidence level (see Section 3.3.4)
& define a default value for the Recovery/Repair time for those records which do

not contain the event duration information (a suggested value is provided)
& choose whether to use a normal distribution or an exponential distribution

(needed for the upper and lower bounds confidence limit calculation)

Then, you will be asked to select a set of records. If you chose the command from the
Statistics-Estimation menu, you will be asked to select a set of records from the
“Specification of Criteria in Selecting Records” form (similar to the Query command
discussed in Section 3.2.1). Then, you will be prompted to choose whether you want to
include any additional records in the analysis. If you choose “No,” then the results will
be displayed. However, if you choose “Yes,” the “Specification of Criteria in Selecting
Records” form will be displayed again, where you will be able to select the additional
records. After completing your record selection, choose “OK” and the results will be
displayed.

When results are displayed on the screen, you will be given an option to open a text
modeling file (*.mdt files produced in the Model Generator Module) and to bind the
results to parameters in the file.
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3.4.5 Coverage

This command can be found in both the Statistics-Estimation menu and Query
Processing menu. Use this command to estimate fault tolerance (or failure) coverage, and
its upper and lower bounds at a specified confidence level. Coverage is the probability of
failure detection and recovery given that a failure has occurred. The binomial
distribution is assumed in estimating upper and lower bounds.

When you run this command, you will be first prompted to specify a confidence level
(see Section 3.3.4). Then, you will be asked to select a set of records. If you chose the
command from the Statistics-Estimation menu, you will be asked to select a set of
records from the “Specification of Criteria in Selecting Records” form (similar to the
Query command discussed in Section 3.2.1). Then, you will be prompted to choose
whether you want to include any additional records in the analysis. If you choose “No,”
then the results will be displayed. However, if you choose “Yes,” the “Specification of
Criteria in Selecting Records” form will be displayed again, where you will be able to
select the additional records. After completing your record selection, choose “OK” and
the results will be displayed.

When results are displayed on the screen, you will be given an option to open a text
modeling file (*.mdt files produced in the Model Generator Module) and to bind the
results to parameters in the file.

3.4.6 Multiple Statistics

The “Multiple Statistics” command can be found in both the Statistics-Estimation menu
and Query Processing menu. This command is used to generate a set of commonly used
statistics and dependability measures from the selected data.

When you run this command, you will be first prompted to specify a confidence level
(see Section 3.3.4). Then, you will be asked to select a set of records. If you chose the
command from the Statistics-Estimation menu, you will be asked to select a set of
records from the “Specification of Criteria in Selecting Records” form (similar to the
Query command discussed in Section 3.2.1). After completing your record selection,
choose “OK” and the following results will be displayed.

& Total Number of Events
& Total Operating Time: Elapsed time multiplied by the number of copies
& Total Event Duration: Sum of the event duration field of all selected records
& Availability: (Total Operating Time - Total Event Duration)/(Total Operating

Time)
& Unavailability: (Total Event Duration)/(Total Operating Time)
& Failure Rate Mean: (Total Number of Events)/(Total Operating Time)
& Failure Rate Lower Bound: Assuming the failure arrivals follow an exponential

distribution, this number represents the lowest failure rate that can be expected
with the confidence level specified by the user.



MEADEP User’s Manual  35

& Failure Rate Upper Bound: Assuming the failure arrivals follow an exponential
distribution, this number represents the highest failure rate that can be expected
with the confidence level specified by the user.

& Recover/Repair Rate Mean: (Total Number of Events)/(Total Event Duration)
& Recovery/Repair Rate Lower Bound: Assuming the recovery/repair times follow

an exponential distribution, this number represents the lowest recovery/repair
rate that can be expected with the confidence level specified by the user.

& Recovery/Repair Rate Upper Bound: Assuming the recovery/repair times follow
an exponential distribution, this number represents the highest recovery/repair
rate that can be expected with the confidence level specified by the user.

& TBE Mean: Mean time between events occurring on any copy of the
systems/components

& TBE Standard Deviation: The standard measure of the divergence of the times
between events from the TBE mean

& TBE Minimum: The minimum time between events
& TBE Maximum: The maximum time between events
& TTR Mean: The average event duration (Time-To-Recovery/Repair)
& TTR Standard Deviation: The standard measure of the divergence of the event

durations (Times-To-Recovery/Repair) from the TTR mean
& TTR Minimum: The minimum event duration (Time-To-Recovery/Repair)
& TTR Maximum: The maximum event duration (Time-To-Recovery/Repair)

3.4.7 Query Files

A query file is a text file that represents one or more query specifications. The file
contains the same information that you would have entered in one or more query sessions
(see Section 3.2.1 on Querying Records). Each command in the Query-Processing menu
reads a query file created by the user prior to command execution. Query files are useful
when well-defined reliability/availability analyses need to be run on multiple data sets
(e.g. monthly failure data analysis).

The following is an example of a query file:

StartDate 95/6/12
EndDate 96/6/30
Type G/G
Location ZSE
Copies 8

StartDate 95/6/13
EndDate 96/6/30
Type G/G
Location ZLC
Copies 6

StartDate 95/8/5
EndDate 96/6/30
Type G/G
Location ZDV
Copies 8
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StartDate 95/9/29
EndDate 96/6/30
Type G/G
Location ZAN
Copies 5

StartDate 95/10/27
EndDate 96/6/30
Type G/G
Location ZTL
Copies 10

This query file can be used to estimate the failure rate for the G/G type failures. The data
were collected from five different locations: ZSE, ZLC, ZDV, ZAN, and ZTL. Each
location has a different start date when the system started operation. Each system has a
different number of the G/G components from which the data were collected.

A query file can contain one or more query segments, each separated by a single blank
line. Each query segment is equivalent to a screen query specification. A query segment
can have from one to 14 lines, each line starting with one of the following keywords:

& StartDate
& EndDate
& StartTime
& EndTime
& MaximumDuration
& MinimumDuration
& Type
& Location
& Subsystem
& Component
& Cause
& Criticality
& Coverage
& Copies

Following each keyword is one or more spaces. Then one or more values can be
specified, depending on the field. For the keywords: StartDate, EndDate, StartTime,
EndTime, MaxDuration, MinDuration, Coverage, and Copies, only one value can be
specified. For all other keywords, one or more values can be specified.

The format for the StartDate or EndDate value is yyyy/mm/dd.

The format for the StartTime or EndTime value is hh:mm:ss.

The value for MaxDuration and MinDuration is a real number between 0 and 1,000,000
(hours).

The value for Coverage is either 0 or 1.
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The value for Copies is an integer of 1 or greater. This value represents the number of
systems or components from which the current selected data were collected.

For keywords: Type, Location, Subsystem, Component, Cause, and Criticality, multiple
values can be specified where each value must be separated by a comma. The wild-card
character, %, can be used to match any substring. For example, HW% can match
HW-CPU, HW-Memory, HW-Bus, etc. 

If any of the above keywords is not included in the segment, no restriction will be
applied to the corresponding field in the record selection.

3.5 Clustering Analysis

This command can be found in both the Statistics-Estimation menu and Query
Processing menu. Use this command to merge multiple events into clusters. A cluster is a
group of one or more events, each occurring within a specified time interval of each
other.

You will be asked to specify this time interval in days, hours, or minutes. Then, you will
be asked to select a set of records. If you chose the command from the
Statistics-Estimation menu, you will be asked to select a set of records from the
“Specification of Criteria in Selecting Records” form (similar to the Query command
discussed in Section 3.2.1). After completing your record selection, choose “OK” and the
results will be displayed.

Otherwise, if you chose the command from the Query Processing Menu, you will be
prompted to open a query file which would select a set of records for you (as indicated in
the query file). Once you open the query file, the results will be displayed.

Results will be displayed in terms of Cluster Density (the number of events in a cluster).
For each cluster density, the following information will be calculated:

& Cluster-Count — number of clusters with that cluster density
& Average-Span — average time span between the first and last events in clusters

of that density and
& MTBE-Within-Cluster — Mean Time Between Events in all clusters of that

density

Note: For a cluster density of one (clusters with only a single event), the values for
Average-Span and MTBE-Within-Cluster are undefined, and are therefore left blank in
the output.
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4. Data Pre-Processor (DPP) Module

The Data Pre-Processor (DPP) Module enables you to translate existing reliability and
failure databases (not in MEADEP format) to the MEADEP required format. Data
formats supported by MEADEP include ASCII delimited text and a variety of databases
such as Access, dBASE, and Paradox. MEADEP also supports other formats on your
system which have existing Open DataBase Connectivity (ODBC) Drivers attached (for
more information on ODBC see the web page in the following location:
www.microsoft.com/odbc/wpapers/odbcbg.htm). MEADEP data are stored in records,
where each record represents a single event, in the Access database format.

The following sections describe the data translation process and how to get started using
the DPP module.

4.1 Getting Started

The first operation in DPP is to open an existing data source. A data source includes the
data a user wants to access and the information needed to get to the data. A data source
may contain information about a specific database (i.e. location, name) or can be a
directory containing a set of files you want to access. To open an existing data source, do
the following:

1. Choose “Select Source Database” under the File menu. 
2. In the “Select Data Source” box, under the “Machine Data Source” tab, select

the data source that contains the data that you want to convert into the MEADEP
format and click “OK”.

3. In the “Input Table Selection” box, select the table you wish to open.

After you have done the above procedures successfully, DPP’s main form will pop up.
DPP’s main form is shown in Figure 18 below.
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Figure 18   DPP’s Main Form

4.2 Data Conversion

The data conversion performed by the DPP module is guided by a mapping between
source data fields (fields in your database) and the MEADEP data fields. Figure 18
shows the MEADEP data scheme consisting of 13 fields. See Section 3.1 for a listing
and description of these fields.

The main form enables you to map the fields in your database to the MEADEP specific
fields shown on the form. Next to each field in the form is a text box with a down arrow.
Clicking this arrow will display a list of all the fields that exist in your database. An
example is shown in Figure 19 below.
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Figure 19   Mapping Fields

At a minimum, the “EventID” and “Date” fields have to be paired with an appropriate
field from your database. Each field’s content must be in the format which is prescribed
in parenthesis. After you are done assigning the desired fields, click “OK”. A box should
appear telling you that you have finished the mapping process. It will also prompt you to
open an Access database where it will be able to display the converted data. After
clicking “OK”, go to the File menu and select the “Select Destination Database”
command. The “Select Data Source” box will be displayed again. Under the “Machine
Data Source” tab, you must choose an existing Access data source or create a new
Access data source by pressing the “New” button.

If you choose an existing Access data source, then you will be prompted to choose from
a table in the database or create a new one. If you choose from an existing table (make
sure that the table is in the MEADEP required format), then you will be given the
option of overwriting the current data or appending to it.

Otherwise, if you choose to create a new Access data source and database, follow
these instructions:

1. In the “Create New Data Source” box, select either the “User Data Source” or
the “System Data Source” option and click Next. If you are running Windows
NT, and you choose the “User Data Source” option, then other users must use
the same logon as you to see this data. However, if you choose the “System Data
Source” option, than other users can also access the data even if they use a
different logon.

2. Then, select the “Microsoft Access Driver” and click Next and then Finish.
3. In the “ODBC Microsoft Access 97 Setup” box, select “Create” and enter the

database’s name and location.
4. Choose “OK”.
5. Enter information about the data source, such as its name and description.
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Figure 20   Date Extraction Dialog Box

6. Choose “OK”.
7. In the Select Data Source box, choose the data source you just created under the

“Machine Data Source” tab and Choose “OK”.
8. Choose “Create New Table” and enter the table’s name.
9. Choose “OK” twice.

This will start converting the data and will prompt you when complete.

Converting Date Information

Because of the large variety of date and time representations in existing databases,
MEADEP provides you with the capability of parsing these formats to convert them into
the appropriate form.

This command can be found in the Options menu and can be used to extract the
necessary information from the current date field and convert it into the MEADEP
required date format. Figure 20 shows the “Date Extraction” dialog box.

In the figure above, an example is shown where the necessary date information is
extracted from the current date field and converted into the MEADEP format. The “Date
extraction specifications” are used to do this. In this particular example, the specified
“start position” and “length” values will extract:

& “96” for the year
& “01” for the month
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& “03” for the day

The result will be in the following MEADEP format: 1996/01/03

After completing the conversion, you can open the database you created in the Data
Editor and Analyzer (DEA) module and perform the desired operations.



Block 1 Block 2 Block 3

Second Level-
 Parallel Block Diagram

Top Level-
 Serial Block Diagram

Block 5

Block 4

State 1 State 2

Second Level-
 Markov Diagram

Frame 1

Third Level-
 Markov Diagram

Block 9 Block 10

State 3 State 4

Third Level-
Series Block Diagram

Block 8Block 7Block 6

Third Level-
Series Block Diagram

Tree.vsd

MEADEP User’s Manual  43

Figure 21   MEADEP Model Hierarchy Example

5. Model Generator (MG) Module

The Model Generator (MG) is a graphical drag and drop interface for constructing
reliability and availability models. A model is developed hierarchically, from the top
level down. Each level can be one of the following:

& A diagram of serial or parallel reliability blocks including the k-out-of-n block
(reliability block diagram)

& A diagram of weighted blocks including the k-out-of-n block (weighted block
diagram)

& A Markov chain (Markov chain diagram)

Figure 21 shows an example of a model hierarchy that contains both Block and Markov
diagrams.

For a block diagram, you can draw blocks and links between blocks (see Section 5.1.1).
For a Markov diagram (Section 5.1.2), you can:

& Draw states and transition arcs between states,
& Specify a reward value for each state, 
& Specify a transition rate for each transition arc and
& Specify the initial state and the failure state for the model.

When the model construction is completed,  the diagrams are saved in a graphical
modeling file (*.mdg) for reuse.
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From the model, MG can generate a text modeling file (*.mdt). This modeling file
contains the model specifications which the Model Evaluator (ME) module uses to
evaluate the model and obtain results (see Section 6.1 for more information on text
modeling files).

MG is also capable of using pre-designed library files (*.mdl) for increasing
productivity. A library file is a graphical modeling file that defines the structure of a
dependability model but does not contain parameter values. This capability allows you to
re-use previously developed and tested models and can greatly reduce model
construction time (see Section 5.1.13 for more information on library files).

MG also allows you to save a model diagram as a Microsoft Windows metafile. This
metafile can then be imported into word processors and other Windows programs.

5.1 Starting A Design

To start a new design, click the “New” command under the File menu. You will be
presented with a dialog box asking you which type of diagram you want to create as your
top-level diagram. After you choose the type of diagram, it will prompt you to give it a
name. Then, the top level diagram window will be displayed. The next sections describe 
the type of diagrams you can choose from.

5.1.1 Block Diagrams

Both reliability block diagrams and weighted block diagrams are called block diagrams.
A block diagram is a graphical method of depicting the components in a system and their
connections in terms of functioning requirements. Each component can be represented by
a block. A block can be a parent block which has a sub-diagram or an elemental block
which has no sub-diagram.

Block diagrams must be in the following format:

& At least one block
& Exactly two terminals (source and destination)
& At least two links

5.1.1.1 Reliability Block Diagram

In a reliability block diagram, blocks may be connected in a serial pattern or a parallel
pattern (see Figure 22 and Figure 23 below). If two or more blocks are connected in a
serial system, this would require that all blocks be functional for the system to be
functional. If two or more blocks are connected in a parallel system, this would require
that at least one of the blocks be functional for the system to be functional. You cannot
have part of the diagram in a serial pattern and part in a parallel pattern. However, you
are able to model a series and parallel system as seen in Figure 24.



7adX`)

7adX`(

7adX`'7adX`&

7adX`'

7adX`&

7adX`)7adX`(

Block 1

Block 4

Block 2

Block 3 Block 5 Block 6

Block 7

Block 8

Block 9

Block 1 Block A Block 5 Block 6 Block 9Block B

Block 4

Block 2

Block 3

Block 8

Block 7

Second Leve l
Mode l  A

Second Leve l
Mode l  B

Top Level  Model

System Block
Diagram

MEADEP Model Para l le l .vsd

MEADEP User’s Manual  45

Figure 22   Blocks in Series Figure 23   Blocks in Parallel

Figure 24   Modeling a Series and Parallel System in MEADEP

Block diagrams can only be drawn in one direction, starting from the source terminal and
ending at the destination terminal.
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Figure 25  A Weighted Block Diagram

Block diagrams can be expanded to lower level diagrams using expandable blocks (see
Section 5.1.6).

5.1.1.2 Weighted Block Diagram

A weighted block diagram represents a system consisting of a number of components. 
Each component contributes to the system availability or reliability with a certain
probability, or weight.  For a weighted block diagram, the diagram level availability (or
reliability), A (or R) is calculated by

A = W1*A1 + W2*A2 + … + Wn*An

where Wi and Ai represent the weight and availability for component i.

In a weighted block diagram, each block represents a component.  Blocks are connected
by links in series, like a serial block diagram.  To distinguish with the reliability block
diagram, a link connecting two weighted blocks has a small circle at the center of the
link. A weighted block diagram must have at least two block, exactly two terminals and
links to connect between blocks and terminals. An example of weighted block diagram is
shown in Figure 25 where �, µ, and w represent failure rate, recovery rate, and weight,
respectively.

5.1.1.3 K-out-of-n Block Model

A k-out-of-n model is a model in which k out of the n components in the modeled system
must operate for the system to operate properly. A “k-out-of-n” model can only be set to
a parent block (which has a sub-diagram). There are two integer parameters associated
with a k-out-of-n block: k and n. To set a block to the k-out-of-n model, just run the Set
k-out-of-n Block command under the Options menu (see Section 5.1.13). You will be
asked for the n and k values for the block. Note that k should not be greater than n. 

5.1.2 Markov Chain Diagram

A Markov model consists of system states and transitions from one state to another. A
system state represents a combination of both operational and failed components in the
system. The system stays in a state for a random time, defined by an exponential
distribution, and then goes into another state. A transition from one state to another state
is characterized by a transition rate. A Markov model can be solved mathematically to
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Figure 26   Markov Model

obtain reliability and availability measures. For example, the expected proportion of time
that the system spends in the failure states, which is called the system unavailability, can
be calculated.

Markov diagrams must be in the following format:

& At least two states.
& At least one transition out of every state such that each state is connected to all

other states directly or indirectly.
& Each transition must have a transition rate (see “Adding Transitions” Section

5.1.3.5).
& An initial state and a failure state must be specified for each Markov diagram.

For example, as you can see in the Markov diagram below (Figure 26),  there are at least
two states, at least one transition with its appropriate transition rate, an initial state and a
final state. In this example, the parameter � represents the failure rate and the parameter
µ represents the recovery rate.

Since a system can be partially functioning (e.g., in a 4-processor system, one processor
can fail while the other three processors can still be working), a reward value must be
assigned to each state to reflect the system performance. A reward value of 1 means that
the system is fully functioning. A reward value of 0 means that the whole system has
failed. A reward value between 0 and 1 means that the system is partially functioning.
The reward values will be used in the availability/reliability calculation by the ME
module.

Markov diagrams can be organized hierarchically. That is, they can be expanded to lower
level diagrams using frames (see Section 5.1.3.6). This hierarchical organization
simplifies the model thereby facilitating understanding and reducing the likelihood of
errors.

The following subsections describe some of the commands associated specifically with
Markov Diagrams.

5.1.2.1 Edit Expression/Reward

The “Edit Expression/Reward” command can be found in the Options menu. Use this
command to edit an expression belonging to a transition or a reward belonging to a state.
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When you choose this command, the cursor will appear as an arrow with a question mark
inside it. Go to the object you want to edit and click on it. For a transition, click on the
transition arrow. A dialog box will appear enabling you to change the current value.
Change the current value to the desired one and click “OK”. If you changed a transition’s
expression, the new expression will be shown on the diagram.

5.1.2.2 Replace Parameter Names

The “Replace Parameter Names” command can be found in the Options menu. When you
choose this command, the “Parameter Replacement” dialog box will appear. This box
will enable you to edit the parameter names that are in the diagram. When this box
appears, it will display a parameter. Edit the parameter and click “OK”. Otherwise, if
you don’t want to edit it, click “Cancel”. Another parameter will appear. Follow the
above procedures until no other parameters are displayed. This command is particularly
useful when you read a library file containing Markov models, because you normally
want to change the parameter names in an imported Markov model.

5.1.2.3 Build Parameter-Value List

The “Build Parameter-Value List” command can be found in the Options menu. When
you run this command, a list of all parameter names and associated values in the current
Markov diagram will be displayed as a text object. Only those parameters which were
assigned values will appear in the “Parameter-Value” list. For information about
assigning parameters, see Section 5.1.11.

5.1.2.4 Set Initial State

The “Set Initial State” command can be found in the Options menu. A valid Markov
model must have an initial state. An initial state is usually a normal, working state. Use
this command to set the initial state for a Markov model. After you click this menu item,
the cursor will appear as an arrow with a question mark inside it. Go to the state that you
want to be the initial state and left click inside it. This state will now represent the initial
state.

5.1.2.5 Set Failure State

The “Set Failure State” command can be found in the Options menu. A valid Markov
model must have a failure state. A failure state is when a system fails to perform its
function(s). Use this command to set the failure state for a Markov model. After you
click this menu item, the cursor will appear as an arrow with a question mark inside it.
Go to the state that you want to be the failure state and left click inside it. This state will
now represent the failure state.

5.1.3 Adding Objects

Objects to be added to a diagram depend on the type of the diagram. As shown in Figure
27, a block diagram has blocks, terminals and links. As shown in Figure 28, a Markov
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Figure 27   Block Diagram with
Blocks, Terminals, and Links

Figure 28   Markov Model with Frame,
States, and Transitions 

diagram has states, transitions and frames. The following sub-sections describe these
objects and how to add them.

5.1.3.1 Adding Blocks

This command is only applicable in block diagrams. To add a block in a block diagram,
choose the “New Block” command from the Items menu. You will be first asked to enter
a name for the block. A name must start with a letter followed by up to 31 letters, digits,
or underscores. After entering a name, you will be asked which of the following block
types you want:

& Expandable block
& Constant block
& Exponential block
& Weibull block

An expandable block means that the block can later be expanded to a lower level
diagram.  It is initially not associated with any parameter. The other three block types are
all elemental blocks which have no sub-diagrams. A constant block means that the block
will be assigned an availability or reliability value (between 0 and 1 including 1) but
cannot be expanded to lower levels. An exponential block is associated with a failure
rate (�) and a recovery rate (µ), and the failure arrival time is assumed to follow the
exponential distribution determined by �. A Weibull block is associated with two failure
rate parameters (� and �) and a failure rate (µ), and the failure arrival time is assumed to
follow the Weibull distribution determined by � and �. If you choose any of these three
elemental blocks, you will be asked to enter values for the associated parameter in a
following dialog box. Both exponential and Weibull blocks can later be expanded to a
lower level diagram, but the associated parameters will be deleted. Any expanded block
(which already has a sub-diagram) can be set to a k-out-of-n block. 

After choosing the block type and entering parameters (for elemental blocks), the block
will then appear on the screen waiting for your next command.
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5.1.3.2 Adding Terminals

This command is only applicable in Block diagrams. To add a terminal to a block
diagram, just choose the “New Terminal” command from the Items menu. The new
terminal will appear on the screen where you will be able to move it and link it to other
objects.

5.1.3.3 Adding Links

This command is only applicable in block diagrams. A link is used to connect two
objects (block or terminal) in a block diagram. To add a new link in a block diagram,
choose the “New Link” command from the Items menu. Then, click inside the source
object and hold the button down. Drag the mouse to the destination object and release
the button inside it. A link will then appear between the source object and destination
object. When adding links, be sure to always add them in the same direction.

5.1.3.4 Adding States

This command is only applicable in Markov diagrams. A state is a status combination of
all components in your system. To add a new state to a Markov diagram, choose the
“New State” command from the Items menu and give it a name. You will then be asked
to assign a reward value for the state (see Section 5.1.2 for an explanation on reward
values).

5.1.3.5 Adding Transitions

This command is only applicable in Markov diagrams. A transition starts from a state
and ends at another state. To add a new transition to the current Markov diagram, choose
the “New Transition” command from the Items menu. Then, click inside the source
object and hold the button down. Drag the mouse to the destination object and release
the button inside it. You will then be asked to enter an expression for it. The expression
represents the transition rate from the source state to the destination state and can contain
numbers, parameters and operators. 

& A number must be an integer or real number.
& A parameter must start with an English or Greek letter and can have up to 31

letters or digits. An underscore is also acceptable as part of the parameter string.
& An operator must be a +, -,*, /, or ^ for powers.

5.1.3.6 Adding Frames

This command is only applicable in Markov diagrams. A frame is what is used in a
Markov diagram to expand to lower-level diagrams. To add a new frame to the current
Markov diagram, choose the “New Frame (submodel)” command from the Items menu.
You will be prompted to give it a name and to choose two parameters. The first is a
failure rate and the second is a recovery/repair rate. Because the model is evaluated
starting from the lowest level up, the values of the failure and recover/repair rates will be
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Figure 29   Frame with Failure and Recovery Rates

taken from the sub-diagram and assigned to the user-defined parameters in the parent-
diagram.

For example, as you can see in the Markov diagram below (Figure 29), the parameter �

represents the failure rate and the parameter µ represents the recovery/repair rate. As we
mentioned above, the values of the failure rate and recovery/repair rate will be taken
from sub-diagram “Frame” and will be assigned to the parameters � and µ, respectively.

5.1.3.7 Adding Text Objects

To add a text object to the current diagram, choose the “New Text Object” command in
the Items menu. A text object contains one or more lines of text. After clicking the
command, you will be asked to enter text. When you finish entering the text and click
“OK”, the text will appear in your diagram and you will be able to move the text to any
place in the diagram.

5.1.4 Moving Objects

To move an object, just click inside it and drag it to a new location. Only objects having
an independent location may be moved, i.e. blocks, terminals, states and frames. A link
or transition cannot be moved, for it is dependant on the location of the objects it is
connected to. However, you may click on a transition and drag it, thereby forming a
midpoint if one did not exist.

5.1.5 Deleting Objects

To delete an object, choose the “Delete Object” command in the Items menu. The cursor
will change its shape to a deletion cursor. Then, click the object you want deleted. The
clicked object and all other objects that are dependant on it will be deleted. For example,
when a block is deleted, any links connected to the block and any sub-diagram belonging
to the block will also be deleted.
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5.1.6 Expanding Diagrams

A non-constant block in a block diagram and a frame in a Markov diagram can be
expanded to lower level diagrams. To do this, choose the “Expand” command in the
Diagram menu. The cursor will change its shape to a magnifying glass with a plus sign in
it. Click the block or frame you wish to expand and you will be prompted to choose
which type of sub-diagram you want (Block diagram or Markov diagram). After you
choose the type, a new, empty diagram will be created. The new diagram will have the
same name as the object which owns it, i.e. the block or frame which was expanded to
form this diagram.

This command can also be used to view lower-level diagrams.

5.1.7 Contracting Diagrams

A lower level diagram may be contracted in order to return to the higher level diagram,
i.e., the parent of the lower-level diagram. To do this, choose the “Contract” command in
the Diagram menu. When you click on this command, the higher level diagram will be
displayed. Since the main diagram is the highest level, it cannot be contracted.

5.1.8 Copying and Pasting Diagrams

Use the “Copy Diagram” command in the Diagram menu to copy the current diagram
(including all of its sub-diagrams). After you choose this command, navigate (by using
the Expand and Contract commands) to the place where you want to paste the diagram.

Then, use the “Paste Diagram” command found in the same menu to paste the diagram(s)
that you had just copied. After the paste operation, you may want to change block/state
names (see Section 5.1.12 Change Block/State Name) and replace parameter names in
the diagram (see Section 5.1.2.2 Replace Parameter Names ). Please note that when
pasting, MG will draw over any objects that are in the current diagram.

5.1.9 Validating Models

Use the “Validate Model” command in the Options menu to check the validity of your
diagrams. You can validate the entire model or a sub-model by navigating to the diagram
you want to validate and choosing this command. MG will then check the current
diagram and all its sub-diagrams to see if they are valid. If any part of the model is
invalid, you will be informed of the problem. If you want to check the validity of the
entire model, go to the top-level diagram and run this command.

5.1.10 Entering and Displaying Design Information In Diagrams

The “Enter Design Information” command can be found in the Options menu and can be
used to enter the following information about the diagram:

& who designed it 
& when it was designed  
& who checked it and
& version or control number
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This information is not required, but is useful for large scope design and management.

You can display this information in your diagram by choosing the “Display Design
Information” command in the same menu. The information will be displayed in the same
way as a text object is displayed.

5.1.11 Assigning Parameter Values

The “Assign Parameter Values” command can be found in the Options menu. Most
expressions (associated with transitions in Markov diagrams) have parameters inside
them. An elemental block in reliability block diagrams has one to three associated
parameters: either a constant availability/reliability value or one (for the exponential
distribution) or two (for the Weibull distribution) failure rate parameters plus a
recovery/repair rate. A k-out-of-n block has the k and n parameters. A block (for both
elemental block and parent block) in weighted block diagrams has an additional
parameter: weight. Before the model can be evaluated, these parameters must be given a
value. You can assign values to parameters during the model construction time or at the
time the text modeling file is generated. If you wish to assign/reassign a value to a
parameter during the model construction time, choose this command from the Options
menu. The cursor will then appear as an arrow with a question mark inside it. Left click
the block or transition which is associated with the parameters you want to assign values
to and assign a value to each of the parameters.

If you assign parameter values to an expandable block, it will become an exponential
block by default. You can later change it to a Weibull block if you wish.

5.1.12 Change Block/State Name

The “Change Block /State Name” command can be found in the Options menu. Use this
command to change the name of a block or state. When you choose this command, the
cursor will then appear as an arrow with a question mark inside it. Left click the object
for which you want to change the  name of and you will be presented with a dialog box
containing the current name. Change the current name to the desired one (in the format
described) and click “OK”. The new name should appear in the object.

5.1.13 Set k-out-of-n Block

The “Set k-out-of-n Block” command can be found in the Options menu. Use this
command to set an expanded block (which already has a sub-diagram) to the k-out-of-n
block. When you choose this command, the cursor will then appear as an arrow with a
question mark inside it. Left click the block which you want to set to the k-out-of-n block
and you will be presented with a series of two dialogs for you to input the “n” and “k”
values for the block. There is no difference between a regular block and a k-out-of-n
block on the screen. But if you turn on the “Parameters” switch under the View menu, k-
out-of-n (where k and n are the actual values you defined) will show above each k-out-of-
n block.
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5.1.14 Set Exponential Distribution

The “Set Exponential Distribution” command can be found in the Options menu. Use
this command to set the failure arrival time distribution to the exponential function for an
elemental or expandable block (which has no sub-diagram). The cursor will then become
an arrow with a question mark inside.  Right click the block to which you want to set the
exponential distribution.  You will be presented with a dialog box for you to enter the �
(failure rate) and µ (recovery rate) values. If you turn on the Parameter switch under the
View menu, the entered values will show above the block.

For more information on the exponential distribution function used in MEADEP, see
Appendix B.3.

5.1.15 Set Weibull Distribution

The “Set Weibull Distribution” command can be found in the Options menu. Use this
command to set the failure arrival time distribution to the Weibull function for an
elemental or expandable block (which has no sib-diagram).  The cursor will then become
an arrow with a question mark inside.  Right click the block to which you want to set the
Weibull distribution.  You will be presented with a dialog box for you to enter the �, �
(parameters for the Weibull distribution), and µ (recovery rate) values. If you turn on the
Parameter switch under the View menu, the entered values will show above the block. 

For more information on the Weibull distribution function used in MEADEP, see
Appendix B.3.

5.1.16 Library Files

A helpful capability of the Model Generator module is the use of library files. This
capability allows you to re-use previously developed and tested models. A list and
description of the library files provided by in the MEADEP package can be found in
Appendix A.

A library file (*.mdl) is a graphical modeling file that defines the structure of a
dependability model but does not contain parameter values. It can be read into a diagram
during the modeling process at any time. To load a library file into your model, navigate
to the diagram where you want the library file to be loaded and choose the “Read Library
File” command from the  Diagram menu. You will be asked for the filename. After you
give the filename, the file will be loaded, replacing any objects you previously had in
your current diagram.

In addition, you can also save frequently used model diagrams as library files for reuse.
This provision can greatly reduce model construction time. To save a part of a model or
the whole model as a library file, navigate to the diagram you want to save. Choose the
“Write Library File” command from the Diagram menu and give it a filename and
location. The current diagram and all of its sub-diagrams will be saved as a library file.
Parameter values (if they exist) will not be saved to the library file except for the reward
values associated with the states in Markov models.
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5.1.17 Generating Text Modeling Files

To evaluate the model you designed, you must generate a text modeling file (see Section
6.1). This file can then be used by the Model Evaluator (ME) module to obtain results.

To generate the text modeling file, choose the “Generate Text Modeling File” command
in the File menu. First, MG will perform a validation check on the model (Section 5.1.9).
If the model is not valid, you will be prompted to correct the problem. If the model is
valid, you will be asked for a filename and location. Then you will be asked if you want
to generate a text modeling file for both availability and reliability evaluation or for
reliability evaluation only. In the latter case, you don’t have to specify parameter values
for all recovery rates and the generated file can be used to evaluate reliability only.

Next, MG will process your model and produce the text modeling file. During this
process, you will be asked to bind (assign) values to parameters by going through a series
of dialog boxes. Parameter values can be entered manually at this time or can also be
initialized by the DEA and ME modules at a later time.

For each parameter displayed in the dialog box, enter the value with which you wish to
initialize the parameter or click “OK” to keep its original value (if it has one). You can
also choose to define the parameter as an additional expression by clicking “Define” in
the dialog box. Any expression you enter will be added to the output file and you will be
asked to initialize any new parameters introduced in the new expression. During this
process, if you forget where a parameter was defined, you can click the “View diagram
containing the parameter” button to view  the diagram that contains the parameter.

The generated text modeling file consists of the following four sections:

& Parameter Initialization — Parameter names and their bound values
& Evaluation Sequence — A sequence of mathematical expressions
& Markov Definition — Description of states, transitions and rewards for all

Markov chains
& Output Specification — Names of models/submodels for which results will be

generated

You should normally not edit the Markov Definition section of the file. However, you
can change parameters, evaluation sequence, and output specification manually as
described in the next section.



MEADEP User’s Manual  56

6. Model Evaluator (ME) Module

The MEADEP Model Evaluator (ME) module has two major functions:

- Editing text modeling files and 
- Evaluating models defined in the text modeling file.

ME enables you to revise parameters and models and then to calculate results based on
these revisions. In addition, ME can also perform parametric analysis on the data and can
graphically display the results. For this analysis, you can choose from the following four
loop types:

& Loop by Increment (Section 6.1.3)
& Loop by Value Set (Section 6.1.4)
& Loop by Time Increment (Section 6.1.5)
& Loop by Time Set (Section 6.1.6)

ME also allows you to create and edit parameter files and include them in the model
evaluation process. This provision allows you to include a standard parameter list in
multiple modeling files without having to input these parameter values into each file (see
Section 6.1.1 for more information).

The following section describes text modeling files and how to get started using them.

6.1 Getting Started with Text Modeling Files

To begin using the Model Evaluator (ME) module, you must have an existing text
modeling file. Text modeling files can be generated using the Model Generator (MG)
module. Please refer to Section 5.1.14 on how to do this. A text modeling file (*.mdt) is
a text file that contains the following four sections:

& Parameter Initialization — This section lists the model’s parameter names and
their bound values.

& Evaluation Sequence — This section holds a sequence of mathematical
expressions.

& Markov Definition — This section describes the states, transitions and rewards
for all Markov chains.

& Output Specification — This section lists the names of the models/submodels for
which results will be generated.

To open a text modeling file, choose the “Open” command in the File menu. After
opening the file, it should appear on the screen. You can now start generating the desired
results, or run a parametric analysis that will enable you to display your results
graphically. You should normally not edit the Markov Definition section of the file.
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Instead, you should make modeling changes using the MG module in order to ensure
consistency.

The following section describes parameter files and how to use them with your text
modeling file. Then, the subsequent sections describe the results you can generate with
the ME module.

6.1.1 Parameter Files

A parameter file is a text file containing a list of parameters and their initial values. This
provision allows a standard parameter list to be included in multiple modeling files
without having to input these parameter values into each file. Any parameter in a model
can be initialized in the parameter file, modeling file, or both. Since parameter files are
processed before text modeling files, if a parameter is initialized in both files, then the
value in the modeling file will override the value in the parameter file. The
parameter file may also contain parameters that are not defined in the modeling file.

To create a Parameter file, choose the “Create Parameter File” command under the File
menu. Input the parameters with their corresponding values in the format shown in the
box below and save it.

parameter_1 value_1
parameter_2 value_2
parameter_3 value_3

.

.

.
parameter_n value_n

Each line contains one parameter name and its corresponding value. There should be at
least one space separating a parameter from its value.

To edit exiting parameter files, select “Open” under the File menu. In the “Files of type”
box, select the “Text Files (*.txt)” option. Then go to the location of the parameter file
and open it for editing.

To include a parameter file in your calculations, choose the “Include Parameter File”
command under the Option menu. When you select this command, you will be asked to
select a parameter file. After you choose a file, the contents of the selected file will then
appear on the screen in a separate dialog box. You cannot edit the contents of this box.
When this dialog box is on the screen, every calculation you run from the Solution menu
will include the selected file in the evaluation. The dialog box will not disappear until
you turn off the option. To turn off the option, just click the command again.

A sample parameter file (named “Parameters.txt”) can be found in the Library directory
under your MEADEP directory.
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6.1.2 Regular Results

The “Regular Results” command can be found in the Solution menu. When you run this
command, the current text modeling file will be evaluated once and the following
measures will be generated:

& Failure Rate
& Recovery/Repair Rate
& Availability
& Unavailability, if the “Output Reliability” option is not selected
& Reliability, if the “Output Reliability” option is selected (see Section 6.1.2.2).

Only models (or submodels) specified in the output specification section of the text
modeling file will be included in the calculation. An example output for regular results is
shown in the box below.
 

Model Failure Recovery Availability Unavailability
Name Rate Rate

(per hour) (per hour)

Channel 0.00067126 1 0.999383255 0.00061450164

SafSys 2.254e-006 1 0.999977075 2.292532e-006

Plant 1.113e-008 0.01 0.999988209 1.179126e-006

As you can see, only those results for the “Channel”, “SafSys”, and “Plant” models were
calculated and displayed. The reason for this (as was explained above) is because these
three models were the only models listed in the output specification section of the text
modeling file. In addition, you can also see that there is no “Reliability” value displayed.
This is because (as is explained  in Section 6.1.2.2) the “Output Reliability” command in
the Option menu was not selected before running this command.

The next subsections describe the “Regular Results” related commands.

6.1.2.1 Set Time Period

The “Set Time Period” command can be found in the Option menu. Before generating
results, use this command to set a time period (or interval) for calculating reliability. The
time period given will be stored in a variable called “TIME”, and reliability will be
calculated for the given “TIME”. When you use this command to set the time period, the
“Output Reliability” option (in the same menu) will be turned on automatically. A
default value of 100 hours will be used for the “TIME” variable if you do not specify
one. The unit of “TIME” is in hours and the value of “TIME” could be between 0 and
1,000,000,000 hours.
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6.1.2.2 Output Reliability

The “Output Reliability” command can be found in the Option menu. Before generating
“Regular Results”, choose this option if you want to include reliability values in its
output. The reliability results will be calculated based on the specified value of “TIME”.
You can assign a value to the “TIME” variable using the “Set Time Period” command
found in the same menu (see Section 6.1.2.1 for more details). When you choose this
command, the reliability results for the given “TIME” value will be calculated and
displayed in the output list. If you do not choose this command, the “Unavailability”
values will be calculated and displayed instead.

6.1.3 Loop by Increment

The “Loop by Increment” command is a parametric analysis command and can be found
in the Solution menu. When you run this command, a dialog box will appear prompting
you to do the following:

& Select a parameter from the parameter list
& Specify an initial value for the parameter
& Specify an upper bound value for the parameter
& Specify an increment for the parameter
& Select a model from the model list to evaluate (optional)
& Select a measure from a measure list to generate (optional)

The evaluation process consists of a number of loops. In each loop cycle, the specified
parameter is increased by the increment amount and results are calculated for each new
parameter value. This loop continues until the parameter value exceeds the specified
upper bound value.

After you specify a parameter with its initial, upper bound, and increment values, you
will have to choose which model you want evaluated and which measure you want
generated.

The steady-state dependability measures that can be generated by this command include:

& MTBF (Mean Time Between Failures)
& Availability
& Unavailability
& Yearly-Downtime

The transient dependability measures that can be generated by this command include:

& Reliability
& Interval-Reliability (average reliability over a time interval)

If you choose a single model and a single measure, then only the selected measure will
be calculated for the selected model. This selection will generate a box containing a set
of values for your parameter and their corresponding measure values. You will be able to
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graph the results and save the graph as a Windows Metafile (*.wmf) for inputting into
other programs.

However, if both the “Model to evaluate” and “Measure to generate” boxes are left
blank, then the same measures as those listed in the “Regular Results” section (Section
6.1.2) will be calculated for each parameter value. Also, only the models (or sub models)
specified in the output specification section of the text modeling file will be included in
the calculation. Please note that the results generated from this selection cannot be
graphed.

6.1.4 Loop by Value Set

The “Loop by Value Set” command is a parametric analysis command and can be found
in the Solution menu. When you run this command, you will be asked to specify a
parameter and a set of values for the parameter. The number of loops depends on the
number of values you specify in the “set of values” box. In each loop cycle, a different
value in the value set will be assigned to the specified parameter and results will be
calculated for each new value until all values have been used.

After you specify a parameter and a set of values for it, you will have to choose which
model you want evaluated and which measure you want generated. The steady-state and
transient dependability measures that can be generated by this command are the same as
those listed in “Loop by Increment”. If you choose a single model and a single measure,
then only the selected measure will be calculated for the selected model. This selection
will generate a box containing a set of values for your parameter and their corresponding
measure values. You will be able to graph the results and save the graph as a Windows
Metafile (*.wmf) for inputting into other programs.

However, if both the “Model to evaluate” and “Measure to generate” boxes are left
blank, then the same measures as those listed in the “Regular Results” section (Section
6.1.2) will be calculated for each parameter value. Also, only the models (or sub models)
specified in the output specification section of the text modeling file will be included in
the calculation. Please note that the results generated from this selection cannot be
graphed.

6.1.5 Loop by Time Increment

The “Loop by Time Increment ” command can be found in the Solution menu. This is a
parametric analysis command for evaluating reliability. When you run this command,
you will be asked to specify an initial time, an end time, and a time increment. The
evaluation process consists of a number of loops. In each loop cycle, the Time variable,
“TIME”, is increased by the increment amount and reliability is calculated for each new
Time value. This loop continues until the value of “TIME” exceeds the specified end
time value.

After you specify the above values, you can now select a model and a measure to
evaluate. Only transient dependability measures can be selected in this command. These
transient measures are:
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& Reliability
& Interval-Reliability (average reliability over a time interval)

The selected transient measure will be generated only for the model you select. You can
also choose to leave the “Model to evaluate” box blank, but then the “Measure to
evaluate” box must be “Reliability”. In such a case, the same measures as those listed in
the “Regular Results” section (Section 6.1.2) will be calculated for each “TIME” value
(the “Output Reliability” switch will be turned on automatically before the calculation).
Also, only those models that are specified in the output section of your text modeling file
will be included in the calculation. Please note that the results generated from this
selection cannot be graphed.

6.1.6 Loop by Time Set

The “Loop by Time Set” command can be found in the Solution menu. This is a
parametric analysis command for evaluating reliability. When you run this command,
you will be asked to specify a set of values for the Time variable, “TIME”. The number
of loops depends on the number of values you specify in the “set of values” box. In each
loop cycle, a different value in the specified set will be assigned to the Time variable and
reliability will be calculated for each new value until all values have been used.

After you specify a set of values for the Time variable, you will also be asked to select a
model and a transient measure to evaluate. The measures that can be generated by this
command are the same as those in the “Loop by Time Increment” command. The
selected transient measure will be generated only for the model you select. You can also
choose to leave the “Model to evaluate” box blank, but then the “Measure to evaluate”
box must be “Reliability”. In such a case, the same measures as those listed in the
“Regular Results” section (Section 6.1.2) will be calculated for each “TIME” value (the
“Output Reliability” switch will be turned on automatically before the calculation). Also,
only those models that are specified in the output section of your text modeling file will
be included in the calculation. Please note that the results generated from this selection
cannot be graphed.


